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OVERVIEW 
 General Excel Live Computer Aided Regulation Engineering (“Live CARE”) software provides 

functions to check Excel 50, 80, 100, 500, 600, and Excel Smart, for correct control 
operation. You can check operation either via physical connection to a Controller or 
by using simulation software to mimic controller operation. You can monitor 
hardware and software points as well as z-registers from the schematic, control 
strategy, or switching logic functions. You can also "fix" points and modify z-registers 
(set them to specific values and have the controller maintain those values). You can 
view user addresses, control strategy and switching tables in the schematic.  
 

  Excel Live CARE software matches the functions and windows in Excel CARE 
software to provide an easily recognizable format.  

 
 Manual Assumptions You should know and understand Excel CARE software and its schematic, control 

strategy, and switching logic functions. See Excel CARE User Guide 74-5587 (US) / 
EN2B-0182 ( Europe) for details. 

 
 Manual Organization This manual contains the following chapters: 
 
  This Overview states the purpose of Live CARE, required operator knowledge, and 

manual organization. In addition, newly implemented features are described. 
 
  Live CARE Concepts provides general information on Live CARE software, its 

relationship to other software, and its performance capacity. 
 
  Getting Started explains how to connect to a controller (physically or by simulation), 

initiate Live CARE software, exit Live CARE software, and how to use the on-line 
help function. The chapter also describes the Live CARE main window. 

  Typical Procedures includes step-by-step instructions for Live CARE functions. 
These functions include: 

 
• Select a Plant and the Communication Interface to specify a project, controller, 

and plant for viewing and monitoring. 
• Simulate Controller Operation to simulate an Excel 50, 80, 100, 500, or 600 

Controller; vary the speed of controller simulation; change date and/or time in the 
controller; and select continuous or step-wise functioning. 

• View User Addresses to display user addresses in the schematic view. 
• View Control Strategy to display the control strategy for the selected plant.  
• View Switching Logic to display switching logic for the selected plant. 
• Fix/Unfix Points to change point mode (automatic to manual and vice versa) and 

assign point values or statuses. 
• Modify Flag Points to change flag point  values 
• Modify Z-Registers to change z-register values 
• View/Change Symbol Information to view/change input and internal control 

symbol parameters, internal user addresses, mapped parameters and z-
registersof XFMs. 

• Error Messages provides a list of error messages that can display and explains 
probable causes and solutions. 

 

APPLICABLE LITERATURE 
 Form No. Title 
 
 74-5587 (US) Excel CARE User Guide 
 EN2B-0182 (Europe) Description of Excel CARE and procedures to use Excel CARE functions. 
 
 74-5577 (US) Excel CARE Control Icons User Guide 
 EN2B-0184 (Europe) Descriptions of the control strategy icons in CARE. 
 
 EN2B-162 RACL Editor User Guide 

Graphical Editor for creation oft strategy logic programs for Excel 500 controllers.  
 

 74-3594 (US) ASPECD Editor User Guide 
 EN2B-0185 (Europe) Provides functions to modify the user interface for Excel Operator Terminals. 
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LIVE CARE CONCEPTS 
 Purpose This chapter provides general information on Live CARE software, its relationship to 

other software, and its performance capacity. 
 
 Data Changes Live CARE can change control strategy symbol parameters, point mode, and 

manual values in the controller database. Live CARE does not save any other 
changes (for example, point value or status changes).  

 
 Capacities Live CARE can monitor any point/z-register in a plant. The maximum number of 

monitored points at any one time is 20 per controller.  
 
 Communication Live CARE can either communicate directly with a controller (online) or simulate 

controller function via simulation software. 
 
  Live CARE communicates directly with controllers via the B Port (XI584 Port) on the 

controller and the serial port (RS-232-C) on the back of the Personal Computer 
(PC).  

 
  Live CARE simulates controller function if you select the static simulator interface 

option. See the Getting Started chapter for direct-connect and simulation 
procedures. 

 
 
 Excel Building Supervisor Both Excel Building Supervisor software and Live CARE software can communicate 

with the same controller. Since the Excel Building Supervisor ("XBS") communicates 
with the controllers via the C-bus and Live CARE communicates through the B port, 
both programs can run concurrently without problem. 

 
 XI584 and Live CARE Live CARE and XI584 software both use the controller B Port and thus cannot be 

running at the same time if Live CARE is directly connected to the controller.  
 
 System Performance Response time for Live CARE  varies depending on controller type, the number of 

points/z-registers being monitored, and the number of other programs running at the 
same time as Live CARE. 

 
  The more points/z-registers being monitored, the slower the controller responds. To 

speed response and reduce message traffic, Live CARE requests that the controller 
only report point changes by exception, that is, if a point does not change value or 
status, the controller does not issue a message to Live CARE. In contrast to points 
z-registers are polled continously according to a defined poll cycle time. 
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GETTING STARTED 
 Purpose This chapter describes how to connect to the desired controller or start the 

simulation software; start Live CARE software; and display on-line help. In addition, 
newly implemented features and the Live CARE main window are described.  

 
  The first step is to decide whether to directly connect to a controller or to simulate 

controller function. The next two sections discuss each option. 
 

 

Connect to Controller (Online Monitoring) 
 
 Purpose Physically connect controller to Excel CARE Personal Computer (PC) so that Live 

CARE can read the controller database. 
 
 Requirements The PC must be within 49 ft. (15m) of the controller. At greater distances (up to 3281 

ft. [1000m]), you must add a line driver.  
 
  Use a XW567 Connection Cable, 25-pin straight-through PC-to-modem cable, and 

an Opto-Isolator to connect the PC and controller. The Opto-Isolator SP400A is 
available from Black Box Corporation, P.O. Box 12800, Pittsburgh, PA 15241 ([412] 
746-5500; FAX order number 1-800-321-0746 within the US and 412-746-0746 
outside the US). Also use Power Supply PS015 from Black Box to power the Opto-
Isolator. 

 
 Procedure (Hardware) 1. Exit CARE. Turn off power switches of the PC and printer (if used). 

  
 a. Insert plug on the XW567 connection cable into the socket on the front 

of the controller computer module.  

 b. Insert the other plug on the XW567 connection cable into the DTE side 
of the Opto-Isolator. Connect Power Supply PS015 to the Opto-Isolator 
and set the single-throw DIP switch to the DTE side. 

 c. Keep the distances between the PC and controller short (less than 16 
feet [5 m] either side of the Opto-Isolator) so that the power supply 
conversion from the RS-232 signal lines is not compromised. 

 d. Connect one end of the 25-pin straight-through PC-to-modem cable to 
the serial interface socket on the back of the PC (COM 1 or COM 2).  

 e. Connect the other end of the cable to the 25-pin DCE socket on the 
Opto-Isolator. 

 

C6978

L1
L2
L3
L4
L5
L6

BLACK BOX 
OPTO-ISOLATOR
(SP400A) WITH
POWER SUPPLY (PS015)
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 2. Insert the PC power supply cable into the socket on the back of the PC. 
 
 3. Insert the plug on the power supply cable into a wall socket. 
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 4. If there is a printer: 
 
 a. Insert the printer connection cable into the socket on the back of the 

printer. 
 b. Insert the other end of the printer connection cable into the socket on 

the back of the PC. 
 c. Insert the printer power cable into the socket on the printer. 
 d. Insert the printer power cable into a wall socket. 
 
 5. To start the PC, apply power in the following order: 
 
 a. Switch ON (I) the controller computer module, if not yet running. 
 b. Switch ON (I) the printer. 
 c. Switch ON (I) the PC. 
 
  Always switch on the printer before switching on the PC. Always switch off the 

printer after switching off the PC. 
 

RESULT: Screen display depends on the setup of the software in the PC. To 
operate Live CARE, Windows and Excel CARE software must be 
running. 

 
 6. If Windows is not running (only a DOS prompt on the screen, for example, 

c:>), type win to initiate Windows. 
 
 7. When Windows is running, click the Start menu.  
 
 8. Select Programs and HONEYWELL XL 5000, then click on CARE 3.00.00  
 

RESULT: The Excel CARE window displays. Use the Initiate Live CARE 
section to open a Live CARE window. 

 
 Procedure (Software) To perform online monitoring see the following sections: 

 
• Initiate Live CARE 
• Select a Plant and the Communication Interface 
• Typical Procedures 

 
 

Initiate Controller Simulation 
 Purpose CARE generates an application program for a controller after a successful controller 

translation. Live CARE simulation software creates a simulated controller in your PC 
workstation that maintains application files, interprets RACL programs, and executes 
Time Programs so you can evaluate controller applications before they are 
downloaded into a controller.  

 
  Some of the advantages of using the simulation tool for DDC static testing are: 
 

• You can debug controller applications in accelerated real-time. 
• There are debug productivity savings due to the elimination of Excel 500 and 600 

I/O module selection and addressing during testing. 
• There are debug productivity savings due to the elimination of the B port 

controller download during testing. 
• You can save and load a controller simulation for repeated tests. 
• You can debug an application using a single time step mode. 
• You can fix global point values. 
• Simulation eliminates the time required for controller address assignment. 

 
 Description The simulation is a “static” simulation, that is, you can set input point values, run the 

controller application, and view output point values, but the software does not 
simulate any field inputs/outputs.  

 
  The following diagram illustrates simulation software operation along with CARE and 

Live CARE. The user specifies setup commands (for example, simulated controller 
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date and time, step size) and operation commands (for example, continuous or step 
operation, acceleration of real-time). Simulation software creates a simulated 
controller from CARE controller application program files and runs its application 
program. Simulation software communicates with Live CARE software to receive 
point requests and fix value commands and then return new point values based on 
controller operation. 

User
Time and Elapsed 
 Time Display

Live CARE 
Simulation Software 
Simulated Controller

CARE

Controller Application 
Program Files

Point Requests, 
Parameter Changes, 
and 
Fix Value Commands

Point Values, 
Parameter 
Values, and 
Controller 
Alarms

Live CARE

Setup and 
Operation 
Commands

Parameter 
Changes

 

 

 
 Requirements The controller you want to simulate must have one or more attached plants and be 

translated. See CARE User Guide 74-5587 (US) / EN2B-0182 ( Europe) for 
procedures.  
  
NOTE: Only Excel 50, 80, 100, 500, 600, and Excel Smart Controllers can be 

simulated. 
 
 Procedure To perform simulation see the following sections: 

 
• Initiate Live CARE 
• Select a Plant and the Communication Interface 
• Simulate Controller Operation 
• Typical Procedures 

 
 

Initiate Live CARE 
 Purpose Open the Live CARE window to select a plant and check its control functions. 
 
 Assumption Excel CARE is running and is the active window on the PC. Live CARE is only 

available within Excel CARE.  
 
 Procedure 1. Select a controller in Excel CARE that has at least one attached and translated 

plant. 
 
 2. Click menu item Database, then dropdown item Select to display the Select 

dialog box. Or, click the Select button in the button bar below the menu bar.  
 
 3. Click desired project name (or folder icon). 
 

RESULT: The plants and controllers associated with the selected project 
display. 

 
 4. Click desired controller name (or controller icon) or attached plant, then click 

OK. 
 

RESULT: If you have not already selected the project, the Enter Project 
Password dialog box displays. Enter password and click OK. 
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 A new window displays with controller name in the title and 

controller information in the window. 
 
 5. Click menu item Controller, then dropdown items Tools, Live CARE. This item is 

available only if the currently active (selected) CARE window is a controller or 
attached plant window. 

 
RESULT: The Live CARE main window  and the Open Plant dialog box 

concurrently display.  
 

  To continue with opening a plant see the Select a Plant and the Communication 
Interface section. For description of the Live CARE main window see the 
following sections. 

 

 
 

 Title Line The title line contains the System menu (CARE symbol), the software name (Live 
CARE and window control icons.  
  

 Menu Bar The menu bar contains two items, File and Help. 
  
  The File menu item provides options to select a plant (Open);  and exit Live CARE 

(Exit).  
 

 - See the Select a Plant section to use the Open item.  
 - See the Exit Live CARE chapter to use the Exit item. 

 
  The Help menu item displays a list of help topics that you can click and display. The 

Help menu item also includes an About Live Care... function that displays the About 
Live Care dialog box with software version copyright notice, and memory available.  
 
 - See the On-Line Help section in this manual for details on the on-line 

 help function.  
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On-Line Help 
 Purpose The Help menu item provides access to an on-line version of this user guide and the 

About Live Care dialog box. 
 
  You can also display the on-line user guide by clicking the Help button in any dialog 

box or window. When you click a Help button, the help topic related to that dialog 
box or window displays. 

 
 Procedure 1. Click Help menu bar item. 
 

RESULT: A dropdown list displays with help topics and an About Live Care... 
item: 

 
 Contents displays the contents page of the on-line user guide. 
 Overview displays the same overview information as in this manual. 
 Topics List presents a list of the other sections of this manual that 

are on-line. 
 Search for... displays the Search dialog box so that you can type or 

select words and find them in the on-line user guide. 
 Using Help opens the standard Windows help file. The help file 

describes how to use the help function in general. 
 Applicable Literature displays a list of the form numbers and titles of 

manuals related to Live CARE. 
 About Live CARE... displays the About Live CARE dialog box. 

 
 2. Click desired topic or About Live Care. 

 
RESULT: Text relating to the selected topic displays. Or, for the About Live 

Care item, the About Live Care dialog box displays with software 
version, copyright notice, and memory available. 

 
 

EXIT LIVE CARE 
 Purpose Stop all point monitoring and terminate the Live CARE session.  
 
 Procedure Click File menu item, then dropdown item Exit. 

 
RESULT: The Live CARE window closes and the Excel CARE main window 

redisplays.  
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TYPICAL PROCEDURES 
 Purpose This chapter includes step-by-step instructions for the following functions: 
 

• Select a Plant and the Communication Interface  to select a project, controller, 
and plant for viewing and monitoring. 

• View User Addresses to display user addresses in the schematic view. 
• View Control Strategy to display the control strategy for the selected plant.  
• View Switching Logic to display switching logic for the selected plant. 
• Simulate Controller Operation to vary the speed of controller simulation, change 

date and/or time in the controller, and select continuous or step-wise functioning. 
• Monitoring to start and stop monitoring of points, z-registers and XFM points. 
• Fix/Unfix Points to change point mode (automatic to manual and vice versa) and 

assign point values or statuses. 
• Modify Flag Points to change flag point values 
• Modify Z-Registers to change z-register values 
• View/Change Symbol Information to view/change input and internal control 

symbol parameters, internal user addresses, mapped parameters and z-registers 
of XFMs. 

 
 General Procedure You must first select a project, controller, and plant. After you make your selections, 

Live CARE displays the schematic and user addresses for the plant. You can begin 
monitoring hardware, software and flag points by clicking the arrow heads for the 
hardware points or the abbreviations in the software points line. In addition, you can 
monitor z-registers by selecting the Z-Registers dropdown item from the View menu.  

 
  Or, you can select one of the view options to display control strategy loops or 

switching logic tables. If you select another view, you can stop current point /z-
register monitoring and select other points/z-register to monitor, or continue current 
monitoring and add more points/z-registers for Live CARE to monitor. 

 
  If you are simulating controller operation rather than connecting to a controller, you 

can manipulate simulation values to affect monitored points and test controller 
reaction. 

 
  The following sections describe how to perform these functions. 
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Select a Plant and the Communication Interface 
 Purpose Select a project, controller, or plant; or switch to another project, controller or plant.   
 
 Procedure 1. In the Live CARE main window, click File, then dropdown item Open. 
 
  or 
 
  Select the desired plant or controller in CARE, click Controller, then dropdown 

item Live CARE (see Initiate Live CARE section) 
 

RESULT: The Open Plant dialog box displays.  
 

 
 
 2. Click desired project name (or folder icon). 
 

RESULT: The plants and controllers associated with the selected project 
display in the “Plant and Controller” box. 

 
 3. Click desired plant name (or plant icon). Select only attached plants. Attached 

plants list below the controller where they are attached. 
 
 4. Click OK. This button is not active if the selected plant is not attached. 
 

RESULT: The Communications dialog box displays next if you changed to a 
different project, controller, or plant.  

 

 
  
 Software stops all point monitoring in the previously selected plant. 
      
 If you changed a point's mode (auto to manual or manual to auto) 

and did not return it back to the original mode, a dialog box 
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displays. This dialog box says that one or more point modes were 
changed and not returned back to the original mode. Click OK to 
continue. Or, click Cancel to keep the controller selection and 
correct point mode. 

 
 5. Type the four-digit password for project. The default password is 3333 as 

definied in the care.ini file. If the password was changed via a portable 
operator’s terminal such as the XI581/582 or XI584, you need to enter the new 
password; see site supervisor if unknown. 

 
 6. Click the desired serial port that you wish to use (default is Com 1).  

 
 7. Click the type of interface connection you are using. Static Simulator initiates 

simulation software. If you select Static Simulator, the Ports option becomes 
inactive (gray). 

 
 8. Click OK.  
  Or, to exit without making these selections, click Cancel.  

 
RESULT: If you click OK, software checks whether or not controller name 

matches the name in the controller and whether or not controller 
password matches the password in the Communications dialog box 
(if a password is required). 

 
 If the selected controller name does not match the name in the 

controller, an error dialog box displays telling you the incorrect 
controller name and giving the selected name and the name in the 
controller. Click OK to close the message box. The Open Plant 
dialog box redisplays for another selection. 

 
 If the password does not match that in the controller, an error dialog 

box displays. Click OK to close the message box. The 
Communications dialog box redisplays to allow you to reenter a 
valid password. 

 
 When controller name and password are correct, software initiates 

communication with the selected controller and updates the 
schematic, hardware point, and software point  monitor dialog 
boxes for that plant. The display defaults to the user addresses 
view. The following window is an example of a plant schematic 
display. 
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 Schematic Window 
 

 
 
  If you are simulating controller operation rather than connecting to a controller, the 

Live CARE Simulation window displays over the bottom part of the Live CARE 
window. See the Simulate Controller Operation section for details on manipulating 
simulation values. 

 
 Title Line The same title line displays as for the main Live CARE window. 
 
 Menu Bar The same menu bar displays as for the main Live CARE window with the addition of 

a View menu item. 
 
  The View menu item provides options to view control strategy, switching logic, and 

user addresses for a selected plant.  
 

NOTE: See the View Control Strategy, View Switching Logic, and View User 
Addressessections for details on these items. 
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 Schematic Schematic displays for the selected plant. This schematic is the same as the one 
created during the Excel CARE process. 
 

 View Area The view area displays the control strategy, switching logic tables, or user addresses 
for the plant. You select which function displays here by clicking View, then one of 
the dropdown items.   

 
 Hardware Points The physical points assigned to the plant display on this line. These triangles are the 

same as those shown in Excel CARE. To highlight the user address, position mouse 
cursor over the triangle and hold down the mouse button. If you click an arrow head, 
software begins monitoring the point.   

 
 Software Points The software points assigned to the plant in the control strategy display on this line 

just as they do in Excel CARE. In addition, the name of the software point displays 
above the abbreviated point type. For example, VA is the type (analog pseudopoint) 
and Heat_Degree_Days is the name of the point. To highlight the user address, 
position mouse cursor over the triangle and hold down the mouse button. 
  

  Software points added in the CARE switching logic function appear in the software 
points line in the first available position. 

 
  If you click the abbreviated type (in the box), software begins monitoring the point.  
 
 Z-Registers Z-registers can be accessed by the Z-Register dropdown item from the View menu, 

by clicking a flag point in the software points line or by clicking an XFM symbol. 
  

 XFMs For XFMs internal user addresses and mapped parameters can be monitored by 
selecting the XFM control symbol or by the XFM-Points dropdown item from the 
View menu. 
  

 Status Bar The status bar displays the names of the currently selected project, controller, and 
plant as well as the current mode (always Normal). 

    
 Scroll Bar The scroll bar allows you to move the schematic and other plant items to the right or 

left to view all plant components. Click within the bar to the left or right of the thumb 
(white square), or click the left or right arrows to move the view left or right. 
    

 Continuing Procedures When selecting Static Simulator in the Communications dialog box see the Simulate 
Controller Operation and the Monitoring sections for further steps. 

 
  When selecting B-Port in the Communications dialog box see the Monitoring section 

for further steps. 
 

 

Simulate Controller Operation 
 Purpose Enable DDC application static checkout without requiring controller hardware. You 

can vary speed of controller simulation, change date and/or time in the controller, 
and select continuous or single-time step simulation.  

 
 Requirements This procedure assumes you initiated simulation software as described in the Initiate 

Controller Simulation section.  
The static simulator option is available only for Excel 50, 80, 100, 500, 600, and 
Excel Smart Controllers. 

 
  Simulation software maintains a window in the foreground at the bottom of the Live 

CARE window. This window allows you to control the simulation while Live CARE 
displays the changing values of monitored points. The simulation tool displays 
controller alarm messages, for example, when an analog input is commanded from 
automatic to manual operation. 
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 Procedure Simulating controller operation and monitoring point/z-register value and status 

changes are dynamic actions that require adjustments in the simulation window and 
the Live CARE window. 
 

  The Monitoring, Fix/Unfix Points and Modify Z-Registers sections describe how to 
control and display point and z-register values and statuses in the Live CARE 
window.  

 
  Following is a description of the Simulation window with guidelines for using its 

features. 
 

 

 Simulation Window 
 Simulation Speed 
 Control Bar 
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  The speed control bar allows to operate the controller faster than real time 
(maximum of 18 times faster). For example, you could execute and test the 
equivalent of an 8-hour day’s program in 30 minutes. 

 
  Simulation speed is limited by the hardware platform. For example, a 386, 20 MHz 

PC is limited to 1.7 times simulation speed. You can set the speed faster, but the 
simulation will continue to operate at 1.7 times real time. 

 
  Click the left or right arrows to set the speed slower (left) or faster (right). Or, move 

the thumb (white box) in the scroll bar to the left or right. 
 
 Start Button 

 
 
  Start the controller application program and run continuously. To stop the program, 

click the red Stop button. To run the controller program for a set amount of time, use 
the Step button. 

 
  This button is not active if no application is loaded. 
 
 Step Button 

 
   
  Start the controller application program and run for a specific length of time. Step 

time (“size”) is set in the simulation setup window. Default is controller cycle time.  
 
  If Step Size is shorter than the length of the DDC Cycle Time for the controller 

application program, the simulation will run one complete execution cycle and stop. 
 
  Click the Setup button to display the setup window and change step size, if desired. 

See Simulation Setup Window description later in this section. 
 
  Example: You can use Step Size to set up a simulation to run the equivalent of a 

day of controller operation. Or, just 2 hours or just 15 minutes. 
 
  This button is not active if no application is loaded. 
 
 Stop Button 

 
 
  Stop the simulation. The simulation window remains on display so you can restart 

the simulation as desired. 
 
  This button is not active if no application is loaded. 
 
 Setup Button Display the setup window. The setup window allows you to set date and time in the 

controller; define the length of time for a step simulation; save and restore a 
simulation session; and change DDC cycle time for the controller application 
program. See the Simulation Setup Window description later in this section. 

 
 Help Button Display the on-line help topic related to the simulation window. 
 
 Simulated Time Date and time assigned to the controller. You can change date and time in the 

simulation setup window. Click the Setup button to display the setup window. See 
Simulation Setup Window description later in this section. 

 
  Example: You may want to change date and time to test controller operation on 

Sundays or Holidays. 
 
 Elapsed Time Length of time the simulation has been running. This time does not match real time if 

the Simulation Speed control bar is set faster than normal. Note that at normal 
speed, some workstations  may operate slower than real time. 
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 Simulation Setup 

  
 

 Menu Items The File menu item has the following dropdown selections: 
  

Open Display the Open dialog box to find and select a 
previously saved simulation file (.SSV). 

   
Save If the current application was loaded from an .SSV file or 

previously saved, this function saves the current state of 
the simulation into the current .SSV file. Otherwise, it 
displays the File Save As dialog box so you can enter a 
file name to receive a saved copy of the simulation. 
Default file extension is .SSV. 

 
 For example, you can use the File Save function to save 

a simulation session so that you can continue testing with 
the same controller configuration at a later time. The 
saved controller simulation session includes all the I/O 
point manual values as well as a snapshot of all 
applications. 

 
Save As Display the File Sav As dialog box to enter a file name to 

receive a saved copy of the simulation. Default file 
extension is .SSV. 

 
Exit Terminate simulation software. 
 
IMPORTANT 

Do not execute the Exit menu option if the Live CARE application is 
operating. The following message displays if you try to exit the simulation 
application before Live CARE: 
 
LIVE CARE SIMULATION 
Live CARE still connected! 
Please disconnect before exiting simulator. 
 
Click OK to close the message box. Then, exit Live CARE (File, Exit in the 
Live CARE window). 
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  The Help menu item has dropdown items that go directly to help sections relevant to 

the item. The About CARE Simulation item displays a dialog box that has the current 
software version number and copyright notice. 

 
Simulation Start Date, Time 
 Date and time to assign to the controller. Default is 

current PC date and time. Date and time format follow 
that defined in the international setting in the Windows 
Control Panel. For example, you may want to change 
date and time to test controller operation on Sundays or 
Holidays. 

 
 You can use the following methods to change date and 

time assignment: 
 

  •  Select and type over date and time parts. 
  •  Click the up and down arrows. 
  •  Double-click date to display a calendar: 
 

 
 

 Click the left and right arrows to select different years 
and/or months. Click a date to select it. When the desired 
date is selected, click OK to save the date and close the 
dialog box. 

 
Simulation Step 
Size Length of time the simulation should run when you select 

the Step button in the Simulation window. Default is 
controller DDC cycle time. Integer values only. Select 
and type over to change or click the up and down arrows 
to change. 

 
 If Step Size is shorter than the length of the DDC Cycle 

Time for the controller application program, the 
simulation will run one complete execution cycle and 
stop. 

 
 Example: You can use Step Size to set up a simulation to 

run the equivalent of a day of controller operation. Or, 
just 2 hours or just 15 minutes. 

 
DDC Cycle Time 
 Length of the cycle time CARE calculated during 

translation of the controller application program. Select 
and type over to change or click the up and down arrows 
to change. 

 
OK Save changes and close the dialog box. 
Cancel Close the dialog box without saving any changes. 
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Help Display the related on-line help topic. 
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View User Addresses 
 Purpose Display user addresses for hardware and software points in the schematic. This view 

is the default view when you first open a plant. The user address view provides the 
following functions:  
 
• Monitor software, hardware and flag points 
• Monitor z-registers 
• Fix/Unfix points  
• Modify flag points and z-registers  

 
 Procedure 1. Click menu item View, then dropdown item User Addresses. 
 

RESULT: Software displays user addresses from hardware and software 
points beneath the schematic and above the software points line.  
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 Parts of the schematic do not appear in the window, use the scroll 
bar at the bottom of the window to change the view to include the 
rest of the schematic. Click in the bar or the left and right arrows to 
move the schematic left or right. 

 
 2. For monitoring software, hardware and flag points, and z-registers see the 

Monitoring section. 
  For fixing points see the Fix/Unfix Points section. 
  For modifying flag points and z-registers see the Modifiy Flag Points and Modify 

Z-Registers sections. 
 

 3. To view a control loop or view a switching table, select the View, Control 
Strategy and Switching Logic option respectively.  
 

 4. To exit the user addresses function, select another function from the File or 
View menu items. Software continues monitoring any points that you set up for 
monitoring unless you turn them off (via point/z-register monitor dialog box or 
Monitor(s) dialog box). 

 
 

View Control Strategy 
 Purpose Display control strategy loops for the selected plant. The Control Strategy view 

provides the following functions :  
 

• Monitor software, hardware and flag points 
• Monitor z-registers  
• Monitor XFM points  
• Fix/Unfix points  
• Modify flag points and z-registers  
• Change internal and input parameters of symbols 
• Change internal user addresses, mapped parameters and z-registers of XFMs 

 
 Procedure 1. Click main window item View, then dropdown item Control strategy. 

 
RESULT: The View Control Strategy dialog box displays with a list of control 

strategy loops for the selected plant.  
 

 
  
 If no control loop was previously selected for the current plant, the 

first loop in the list is automatically selected. Otherwise, the last 
control loop viewed is highlighted.  

 
 2. Check/uncheck End current monitoring box, as desired. If the box is checked 

when you click OK, software stops all existing point/z-register monitoring and 
closes the Monitor(s) dilaog box. If not checked, software continues all point/z-
register monitoring. The default mode for this box is checked. If this option is 
gray, there is no current monitoring. 

 
 3. Click desired loop name. Then click OK. (Or, a shorter method is to double-click 

the loop name). 
 
RESULT: The View window displays the selected control strategy loop with all 

control symbols and connected hardware and software points. You 
can scroll the window with the scroll bar.  
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 4. For monitoring points and z-registers see the Monitoring section. 
  For fixing points see the Fix/Unfix Points section. 
  For modifying flag points and z-registers see the Modifiy Flag Points and Modify 

Z-Registers sections. 
  For Viewing/changing control symbol internal and input parameters see the 

View/Change Symbol Inputs and View/Change Symbol Parameters sections. 
  For viewing/changing internal user addresses, mapped parameters or z-

registers of XFMs see the Change XFM Internal User Addresses and Mapped 
Parameters and Change XFM Z-Registers sections respectively. 

 
 5. To view a different control loop, reselect the View, Control Strategy option.  
 
 6. To exit the control strategy function, select another function from the File or 

View menu items. Software continues monitoring any points/z-registers that you 
set up for monitoring unless you turn them off (via point window or Monitor(s) 
window). 
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 Intermediate Values You cannot monitor intermediate values between control symbols in a control 
strategy loop unless you assign a software point to the values. To assign software 
points, return to CARE, add a software point (to the schematic, control strategy, or 
switching logic), and retranslate and download the new database to the controller. 
Restart Live CARE and select that new software point for monitoring.  
 
 

View Switching Logic 
 Purpose Display switching tables for the selected plant. Software automatically begins 

monitoring all points/z-registers in a switching table when you select it. 
 
 Procedure 1. Click main window item View, then dropdown item Switching logic. 

 
RESULT: The View Switching Table dialog box displays with a list of User 

Addresses that have switching tables in the selected plant. The 
dialog box also shows the command values available for the 
selected User Address. If this is the first time you are selecting a 
switching table, the first User Address in the list is selected; 
otherwise, the most recently selected User Address and command 
value are selected.  

 

 
 
 2. Check/uncheck End current monitoring box, as desired. If the box is checked 

when you click OK, software stops all existing point/z-register monitoring 
(excluding the points/z-registers in the selected switching table). If not checked, 
software continues all point/z-register monitoring for points/z-registers already 
being monitored. Default mode for this box is checked. This option is gray if 
there is no current monitoring. 

 
 3. Click desired User Address. 

 
RESULT: Software displays available command values for the selected User 

Address. 
 
 4. Click desired command value. Then click OK. (Or, a shorter method is to 

double-click the value.) 
 

RESULT: The View window displays the selected switching table. The table 
looks just as it does in Excel CARE, except that there are two 
additional columns.  

 
 One new column appears after User Address. The column is gray 

and contains the current value/state of the point. Engineering unit 
does not display. 

 A second column appears between the delay columns and the truth 
table. This new column has bold vertical lines to distinguish it from 
the previous columns. The new column shows the logical equivalent 
of the left side of the table. A 0 displays if the evaluation was false; 
a 1 displays if the evaluation was true.  

 
 Software automatically begins monitoring all points in the displayed 

switching table. 
 



TYPICAL PROCEDURES LIVE CARE 

74-3556-9 (US)   
EN2B-0183 GE51 R0404 (Europe) 

22

 
 

 5. To fix a switching table point, click point value/state in the gray area in the 
switching table. See the Fix/Unfix Points section for more information. 

 
NOTE: Modifiying a z-register value from a flag point within a switching table is 

not possible. 
 
  To monitor points not in the switching table (for example, hardware, software 

and flag points), click point arrow head or abbreviation. For more information, 
see the Monitoring section. 

 
  To fix points not in the switching table see the Fix/Unfix Points section 
  To modify flag points and z-registers not in the switching table see the Modifiy 

Flag Points and Modify Z-Registers sections. 
 
  To view a table for a different User Address and monitor those points, reselect 

the View, Switching Logic option.  
 

 6. To exit the Switching Logic function, select another function from the File or 
View menu items. Note that software continues monitoring any points/z-
registers that you set up for monitoring unless you turn them off (via point/z-
register monitor dialog box or Monitor(s) dialog box). 

 
  Another way to exit is to close the Monitor(s) dialog box. When the dialog box 

closes, software stops all point monitoring, closes the switching logic view, and 
selects the user addresses view to display. 
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 Engineering Unit Point engineering unit and mode(manual or  
 and Mode Display auto) do not display in the switching table. To view engineering unit and mode, 

display the Fix Point dialog box by clicking point value/state in the gray area in the 
switching table.     

  
 Hysteresis and Delays Truth table values do not reflect time delays that may be in the switching table. 

Hysteresis is reflected in switching tables. Therefore, the values have to change by 
the hysteresis value to cause the output to change. You can change time delays by 
clicking on the time delay field and changing the time. 
 
 

Monitoring 
 Purpose Display point/z-register value or status (status only for points) as it changes in the 

controller. Live CARE provides concurrently monitoring of the following items: 
 
• Hardware points 
• Software points 
• Flag points 
• XFM points (internal user addresses and mapped parameters) 
• Z-registers in general, corresponding to flag points and XFMs 
 
There are two ways to monitor items. The first way is to display a monitor dialog box 
that shows value/state, engineering unit, and mode (automatic or manual) of the 
item. The second way is to select a switching table in the View Switching Logic 
function. Software automatically monitors all items in the switching table without 
displaying monitor dialog boxes. Both functions can be used at the same time. 

 
  This section describes monitoring via displaying monitor dialog boxes for the 

selected items. Refer to the View Switching Logic section for a description of 
monitoring switching table items. 
 
NOTE: The way to access the above mentioned items for monitoring is different. 

You find a detailed description in the corresponding Monitor sections. The 
basic procedure is described as follows. 

 
 Assumption The plant is open and the communication interface is selected (B-Port or Static 

Simulator). 
 

 Procedure 1. Select the desired view from the View menu. 
 
 2. To monitor software or hardware points, click the point on the hardware and 

software points line respectively.  
 
To monitor z-registers select the Z-Register dropdown item from the View 
menu, enter the file and index numbers into the fields in the Select Z-Register 
dialog box and click Display. 

 
RESULT: Concurrently two dialog boxes display. 
 On the left-hand side of the screen, the Monitor(s) dialog box 

appears. 
 

 
 

 It is shown after you activate the first item to be monitored. The 
Monitor(s) dialog box controls point monitoring by providing 
functions to restart monitoring, freeze monitoring, refresh screen 
displays, and stop monitoring. You can also restack point/z-register 
monitor dialog boxes on the right-hand side of the screen if you 
moved some and want to put them all back in a column by using 
cascade or tile. 
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 Refer to the Monitor(s) Dialog Box section for detailed description. 
 

 On the right-hand side of the screen each point/z-register selected 
is diplayed in a monitor dialog box indicating that the point is 
currently being initialized . For z-registers the current value is 
displayed. The following figures show some monitor dialog box 
examples for hardware points, software points and z-registers. 

 

 
 

 
 

 
 

 3. Click Start in the simulation software window at the bottom of the screen when 
Static Simulator was selected for the communication interface. When directly 
communicating with a controller via the B-Port or LonWorks communication 
interface monitoring starts automatically after initializing.  

 
RESULT: Each point´s monitor dialog box shows the user address for the 

point in the title line, its current value (for example 302.0) and 
engineering unit (for example, Deg or blank), the status (for 
example On or Off, Normal or Alarm). For z-registers the current 
value is displayed. The current mode of the monitor dialog box is 
indicated as either Auto or Manual and the LED symbol at the left 
corner in one of the following colors: 

 
• Gray 

Indicates normal mode. 
• Green 
 A point update has occurred. A z-register was polled. A z-

register is polled as long as the monitor box is open and the 
Freeze or Refresh option in the Monitor(s) dialog box is not 
selected. 

• Yellow 
 The point is in alarm. Note that the yellow LED shows only if 

you toggle in and out of the Monitor(s) dialog box. There is 
no automatic refresh. 

 
 The following figures show the monitor dialog box examples after 

initializing for the corresponding hardware points, software points, 
and z-registers shown above. 

 

 
 

 
 

 
 

  3. To check point/z-register functions: 
    
 • Note value and state changes (state changes for points only). 
 • Use the Monitor(s) dialog box to stop monitoring, freeze values/statuses, 

refresh values/statuses, and restart monitoring as desired. See the 
Monitor(s) dialog box section for details. 
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 • Use the Fix dropdown item from the system menu (click window symbol) 
in an individual point monitor dialog box to fix a point value/state as 
desired (see the Fix/Unfix Points section for details). 

 • Use the Modify dropdown item from the system menu in an individual z-
register monitor dialog box to change a z-register value as desired (see 
the Modify Z-Registers section for details). 

    
 4. To stop monitoring when using a simulated controller, click Stop in the 

simulation software window at the bottom of the screen.  
   

RESULT: This stops the application program running in the simulated 
controller. All monitor dialog boxes remain open on the screen. 

 
 5. To end monitoring one single point/z-register, click the system menu in the 

individual monitor dialog box and select Close. 
 
 6. To end all monitoring, click Close in the Monitor(s) dialog box or select a 

different plant via Open dropdown item from the File menu. 
  

RESULT: This closes all monitor dialog boxes. The application program is still 
running in the (simulated) controller. Click STOP in the simulation 
software window if you want to stop the application program. 

 
 Special Points: There are three special points that Live CARE always monitors: STARTUP, 

SHUTDOWN, and EXECUTING_STOPPED. These points are automatically 
attached to each EXCEL 5000 controller. You can check the status of these points 
to prove that the application programs are running. Excel CARE User Guide 74-
5587 (US) / EN2B-0182 ( Europe) describes these points and their active/passive 
modes in detail. User addresses display in bold if you hold down the mouse button 
while selecting a point. 

 
 Point Monitoring Limits: You can monitor a maximum of 20 points per controller.  
 
 Points From Other Controllers: Live CARE connects directly to a controller and cannot look at points on other 

controllers unless they are global points on the connected controller. 
 
 Intermediate Values: You cannot monitor intermediate values between control symbols in a control 

strategy loop unless you assign a software point to the values. To assign software 
points, return to CARE, add a software point (to the schematic, control strategy, or 
switching logic), and retranslate and download the new database to the controller. 
Restart Live CARE and select that new software point for monitoring.  
 

 Reporting by Exception:  To reduce message trafficLive CARE requests that the controller only reports point 
changes by exception, that is, if a point does not change value or status, the 
controller does not issue a message to Live CARE. 
 

 Polling: In case a flag point or a z-register has been selected, the displayed value in the 
monitor dialog box will be polled as long as the monitor dialog box is open and the 
Freeze or Refresh option in the Monitor(s) dialog box is not selected. 

 
 Positioning of monitor dialog boxes When you scroll plant information via the scroll bar, the point display and monitor 

dialog boxes remain at the same place on the screen. You cannot scroll them off the 
screen. However, you can move them elsewhere. Click title line and hold down the 
mouse button as you move the monitor dialog box elsewhere. Release mouse 
button when it is in the desired position. 
 

 Double Monitoring If a point/z-register is being monitored and you click it again, software does not open 
another point/z-register monitor dialog box; it simply highlights the existing point/z-
register monitor dialog box.  

 
 Multiple Monitoring Software can monitor a point in a switching logic table and in a point monitor dialog 

box at the same time. For z-registers this is not possible.  
 
 Start Monitoring When using static simulator, monitoring starts after the point/z-register was selected 

and the Start button in the simulation software window was clicked. When directly 
connected to a controller, monitoring is running automatically after the monitor dialog 
box was opened. 
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 Stop Monitoring a Point/Z-Register If you close the point/z-register monitor dialog box (click the System menu and then 
select Close, or double-click the System menu), software stops monitoring the 
point/z-register. 
 

 Stop All Point/Z-Register Monitoring If you close the Monitor(s) dialog box (Close button), software stops all point/z-
register monitoring and removes all point/z-register monitor dialog boxes from the 
screen.  

 
 

Monitor(s) Dialog Box 
 Purpose Control point/z-register monitoring by providing functions to restart monitoring, 

freeze monitoring, refresh screen displays, and stop monitoring. You can also 
restack point dialog boxes on the right-hand side of the screen if you moved some 
and want to put them all back in a column by using cascade or tile: 

 
 Path The Monitor(s) dialog box appears after you select the first item to be monitored or 

after you select a switching table in the switching logic view. It remains on display as 
long as there are items being monitored.  

 

 
 
 Procedure Click desired radio button to perform the following actions: 
 
  Start 

Restart monitoring, if you stopped it or chose the Freeze option. Set by default after 
the dialog box is opened. When connecting directly to a controller, monitoring is 
running automatically. When using the static simulation, the Start button in the 
simulation software window has to be clicked on additionally. Z-registers are polled 
and point updates are displayed when a value/state has changed. 
  

  Freeze 
Stop updating point values/statuses in the point/z-register monitor dialog boxes. Z-
registers are not polled any longer. 

 
Refresh 
Display the latest values/statuses in the point/z-register monitor dialog boxes and 
then freeze the display again. 

 
During the Freeze and Refresh states, software still updates point and z-register 
values/statuses internally but the values do not display.  
Z-registers are not polled any longer. 
This technique allows fast updates when you restart monitoring or request a refresh. 

 
  Close 

The Monitor(s) dialog box closes and all monitoring stops (point/z-registers 
disappear). The current plant and view selection remain on the screen and you can 
either continue or exit Live CARE. 
 

 System menu The System menu in the upper left corner provides the following functions when you 
click the window symbol: 
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  Move 
  Change cursor to the positioning cursor to move the dialog box. 

 
  Close 
  Stop monitoring and close the Monitor(s) dialog box. This function is the same as 

the Close radio button in the Monitor(s) dialog box. 
 

  Cascade 
  Displays points/z-registers in cascade format. Repositions all point/z-register monitor 

dialog boxes in a column down the right-hand side of the screen. 
 
  Tile 
  Displays points/-z-registers in tile format. 
 
  Help 
  Display the on-line help for the Monitor(s) dialog box. 
 

NOTE: After selecting Cascade or Tile, Live CARE saves the last setting and uses 
it during the next monitoring session. 

 
 

Monitor Hardware Points 
 Purpose Display hardware point value or status as it changes in the controller. 
 
  There are two ways to monitor points. The first way is to display a point monitor 

dialog box that shows point value/state, engineering unit, and mode (automatic or 
manual). The second way is to select a switching table in the View Switching Logic 
function. Software automatically monitors all points in the switching table without 
displaying monitor dialog boxes. Both functions can be used at the same time. 

 
  This section describes point monitoring via point selection. Refer to the View 

Switching Logic section for a description of monitoring switching table points. 
 

 Assumption Application program is running in the (simulated) controller. 
 
 Procedure 1. In any view (control strategy, switching logic, or user addresses), click the arrow 

head on the hardware points line to monitor the desired hardware point. 
 

RESULT: The corresponding hardware point monitor dialog box displays 
showing  the user address in the title line, the current value (for 
example 302.0) and engineering unit (for example, Deg or blank), or 
the status (for example On or Off, Normal or Alarm). The current 
mode of the monitor dialog box is indicated as either Auto or 
Manual and the LED symbol at the left corner in one of the following 
colors: 

 
• Gray 

Indicates normal mode. 
• Green 
 A point update has occurred.  
• Yellow 
 The point is in alarm. Note that the yellow LED shows only if 

you toggle in and out of the Monitor(s) dialog box. There is 
no automatic refresh. 

 
 The following figures are examples of displays for an analog point 

and digital point respectively: 
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 The Monitor(s) dialog box displays if not already opened (see 
Monitor(s) Dialog Box section). 

 
  2. To check point functions: 
   
 • Note value and state changes 
 • Use the Monitor(s) dialog box to stop monitoring, freeze values/statuses, 

refresh values/statuses, and restart monitoring as desired. See the 
Monitor(s) dialog box section for details 

 • Use the Fix dropdown item from the system menu in individual point 
monitor dialog boxes to fix a point value/state as desired (see the 
Fix/Unfix Points section for details). 

  
 3. To stop monitoring when using a simulated controller, click Stop in the 

simulation software window at the bottom of the screen.  
   

RESULT: This stops the application program running in the simulated 
controller. All monitor dialog boxes remain open on the screen. 

 
 4. To end monitoring one single point, click the system menu in the individual point 

monitor dialog box and select Close. 
 
 5. To end all monitoring, click Close in the Monitor(s) dialog box or select a 

different plant via Open dropdown item from the File menu. 
  

RESULT: This closes all monitor dialog boxes. The application program is still 
running in the (simulated) controller. Click STOP in the simulation 
software window if you want to stop the application program. 

 
 

Monitor Software Points 
 Purpose Display software point value or status as it changes in the controller. 
 
  There are two ways to monitor points. The first way is to display a point monitor 

dialog box that shows point value/state, engineering unit, and mode (automatic or 
manual). The second way is to select a switching table in the View Switching Logic 
function. Software automatically monitors all points in the switching table without 
displaying monitor dialog boxes. Both functions can be used at the same time. 

 
  This section describes point monitoring via point selection. Refer to the View 

Switching Logic section for a description of monitoring switching table points. 
 

 Assumption Application program is running in the (simulated) controller. 
 
 Procedure 1. In any view (control strategy, switching logic, or user addresses), click  the 

abbreviation on the software points line to monitor the desired  software point.  
 

RESULT: The corresponding software point monitor dialog box displays 
showing  the user address in the title line, the current value (for 
example 0.1) and engineering unit (for example, Deg or blank), or 
the status (for example On or Off, Normal or Alarm). 

 The current mode of the monitor dialog box is indicated as either 
Auto or Manual and the LED symbol at the left corner in one of the 
following colors: 

 
 
 

  
• Gray 

Indicates normal mode. 
• Green 
 A point update has occurred.  
• Yellow 
 The point is in alarm. Note that the yellow LED shows only if 

you toggle in and out of the Monitor(s) dialog box. There is 
no automatic refresh. 
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 The following figures are examples of displays for software points: 
 

 
 

 
 
 The Monitor(s) dialog box displays if not already open (see 

Monitor(s) Dialog Box section). 
 

  2. To check point functions: 
 
 • Note value and state changes 
 • Use the Monitor(s) dialog box to stop monitoring, freeze values/statuses, 

refresh values/statuses, and restart monitoring as desired. See the 
Monitor(s) dialog box section for details 

 • Use the Fix dropdown item from the system menu in individual point 
monitor dialog boxes to fix a point value/state as desired (see the 
Fix/Unfix Points section for details). 

  
 3. To stop monitoring when using a simulated controller, click Stop in the 

simulation software window at the bottom of the screen.  
 

RESULT: This stops the application program running in the controller. All 
monitor dialog boxes remain open on the screen. 

 
 4. To end monitoring one single point, click the system menu in the individual point 

monitor dialog box and select Close. 
 
 5. To end all monitoring, click Close in the Monitor(s) dialog box or select a 

different plant via Open dropdown item from the File menu. 
  

RESULT: This closes all monitor dialog boxes. The application program is still 
running (simulated) controller. Click STOP in the simulation 
software window if you want to stop the application program. 

 
 

Monitor Flag Points 
 Purpose Display of selected flag point value as it changes in the controller. A value is polled 

as long as the monitor box is open and the Freeze or Refresh option in the 
Monitor(s) dialog box is not selected. . 

   
NOTES: Flag points can be seen as z-registers and the format of a flag point 

monitor dialog box is equivalent to a z-register monitor dialog box. 
 
 The z-register and flag points access respectively can be enabled/disabled 

in the CARE.INI file (see SET CARE.INI FILE ENTRIES chapter). 
 

  For modifying z-register values refer to the Modify Z-Registers section. 
 

  There are two ways to monitor flag points. The first way is to display a flag point 
monitor dialog box that shows the current value. The second way is to select a 
switching table in the View Switching Logic function. Software automatically monitors 
all z-registers and points in the switching table without displaying monitor dialog 
boxes. Both functions can be used at the same time. 

 
  This section describes point monitoring via point selection. Refer to the View 

Switching Logic section for a description of monitoring switching table points. 
 

 Assumption Application program is running in the (simulated) controller. 
 
 Procedure 1. In any view (control strategy, switching logic, or user addresses), click the 

desired flag point (abbreviations are: FA = analog flag point, FD=digital flag 
point) on the software points line.  
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RESULT: The Analog Flag and Digital Flag dialog box respectively displays 

showing the current value of the corresponding z-register. The title 
line shows the flag type (FD, FA) and the user address, for 
example, FD:BoilerFailure, FA:Temperature Slope.  

. 

 
 

 The LED symbol at the left corner indicates the current mode of the 
flag point  monitor dialog box:  

 
• Gray 

Indicates normal mode. 
• Green 
 The z-register was polled. The z-register is polled as long as 

the monitor box is open and the Freeze or Refresh option in 
the Monitor(s) dialog box is not selected. 

 
 The Monitor(s) dialog box displays if not already open (see 

Monitor(s) Dialog Box section). 
 
 2. Overwrite the current value if desired by typing the value into the New Value 

field and clicking Modify. For digital flags it is only allowed to enter 0 or 1. For 
analog flags it is only allowed to enter a positive or negative float number. 

 
RESULT: The new value is written to the z-register.  

   
 3. To check point (z-register) functions: 
 
 • Note value changes 
 • Use the Monitor(s) dialog box to stop monitoring, freeze values/statuses, 

refresh values/statuses, and restart monitoring as desired. See the 
Monitor(s) dialog box section for details 

 • Use the Modify dropdown item from the system menu in individual point 
monitor dialog boxes to change a z-register value as desired (see the 
Modify Flag Points section for details). 

 
 4. To stop monitoring when using a simulated controller, click Stop in the 

simulation software window at the bottom of the screen.  
   

RESULT: This stops the application program running in the (simulated) 
controller. All monitor dialog boxes remain open on the screen. 

 
 5. To end monitoring one single point/z-register, click the system menu in the 

individual monitor dialog box and select Close. 
 
 6. To end all monitoring, click Close in the Monitor(s) dialog box or select a 

different plant via Open dropdown item from the File menu. 
  

RESULT: This closes all monitor dialog boxes. The application program is still 
running in the controller. Click STOP in the simulation software 
window if you want to stop the application program. 

 
 
 
 

Monitor XFM Points 
 Purpose Display values/statuses of XFM datapoints which are internal user addresses or 

parameters mapped to software points as they changed in the controller. 
   
 Assumption Application program is running in the (simulated) controller. 
 
 Procedures 1. Select Control strategy from the View menu. 
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RESULT: The View Control Strategy displays.  
 

 
 
 
 2. Select the desired control strategy including the XFM(s) and click OK. 

 
 Selecting from all XFMs 3. Select XFM-Points from the View menu, if you want to choose between all 

XFMs included in the control strategy. For selecting one XFM see the Selecting 
one single XFM section. 
 
RESULT: The Select User Address dialog box displays showing all existing 

XFMs.  
 

 
 

 Each XFM is shown as unique symbol with its position in the control 
loop (column, row) and its name, for example: 
 

 
 

  4. View the user addresses and the mapped parameters by clicking the plus 
symbols at the XFM, Internal Data Points and Mapped Parameters symbol. If 
there are no internal data points and/or mapped parameters available for the 
desired XFM the Internal Data Points and/or Mapped Parameters structure can 
not be expanded (see the XFM enth in the following figure). 

 



TYPICAL PROCEDURES LIVE CARE 

74-3556-9 (US)   
EN2B-0183 GE51 R0404 (Europe) 

32

 
 
   For Internal user addresses and mapped parameters their type, such as VA or 

VD, and their name, such as Heat_Degree-Days or P08_Factor are shown. 
 
  5. Click the internal datapoint or the mapped parameter and click Display. 
 

RESULT: The corresponding monitor dialog box is displayed.  
 

 
 

NOTE: Internal user addresses can be assigned to software and hardware 
points in CARE. For monitoring see the Monitor Hardware Points and 
Monitor Software Points sections respectively. Since parameters can 
only be mapped to software points (except flag points) refer to the 
Monitor Software Points section for monitoring mapped parameters. 

 
 Selecting one single XFM 1. After selection of the control loop as described in step 1 and 2, open the Symbol 

Information dialog box by clicking the control symbol with the left mouse button. 
 

 
 
   or 
 
  Display the context menu by clicking the control symbol with the right mouse 

button.  
 

 
 
 4. In the Symbol Information dialog box, click Internal User Addresses and 

Mapped Parameters and confirm by clicking OK. In the context menu, click 
Datapoints. 
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RESULT:  The Select User Adress dialog box displays showing all internal 

user addresses and mapped parameters of the selected XFM. 
 

 
 
   If there are no internal data points and/or mapped parameters available for the 

desired XFM the Internal Data Points and/or Mapped Parameters structure is 
not expanded. 

 
   For Internal user addresses and mapped parameters their type, such as VA or 

VD, and their name, such as Heat_Degree-Days or P08_Factor are shown. 
 
  5. Click the internal datapoint or the mapped parameter and dick Display. 
 

RESULT: The corresponding monitor dialog box is displayed.  
 

 
 

NOTE: Internal user addresses can be assigned to software and hardware 
points in CARE. For monitoring see the Monitor Hardware Points and 
Monitor Software Points sections respectively. Since parameters can 
only be mapped to software points (except flag points) refer to the 
Monitor Software Points section for monitoring mapped parameters. 

 
 

Search for Datapoints via Keyboard 

 Purpose Quick search to find special datapoint name (mapped parameter or internal 
datapoint) in the Select User Address dialog box. 

   
 Procedure 1. In the Select User Address dialog box, type the complete name or single 

characters (search entry) of the datapoint name you want to find.  
 

RESULT: CARE automatically finds the first name that matches the search 
entry. CARE finds matched datapoint names in closed folders too.  

  
 If a datapoint name you search for is not found, CARE continues 

searching with the next search entry you enter. CARE does not 
distinguish between upper-case and lower-case letters except on 
umlauts or country specific characters.  

 
 2. To find the next name that matches the same search entry click the asterics (*).  
  
 3. To find a different datapoint name enter the new search entry. 

Monitor Points in “No Response” Mode 
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 Purpose Display of a DIO hardware point value/status, which is in “no response” mode, which 
means that the communication between DIO module and controller is interruppted. 
A hardware point in “no response mode” can be changed to manual or automatic 
mode and fixed respectively. Refer to the Fix/Unfix Points section for fixing a point in 
“no response” mode. 

. 
NOTE:  Monitoring hardware points in “no response” mode can only be accessible 

when Live CARE communicates directly with a controller via  
B port. 

 
 Assumption Application program is running in the controller. 
 
 Procedure The procedure for monitoring a hardware point in no response mode is parallel to 

monitoring a normal hardware point (see the Monitor Hardware Points section). In 
comparison to a hardware point which is not in no response mode, the monitor 
dialog box for a point in no response mode additionally shows only a “no response” 
symbol to the right hand side of the LED symbol. 

 

 
 
 

Monitor Points in “Manual Override” Mode 
 Purpose Display value and status of a hardware point, which is in “manual override” by a 

distributed IO (DIO) Module (XFR 522 or XFR 524). This concerns only the DO and 
AO types of the DIO modules.  

. 
NOTES: A hardware point in “manual override” mode is in remote mode and cannot 

be changed to manual or automatic mode and fixed respectively. 
 
 Monitoring hardware points in “manual override” mode can only be 

accessible when Live CARE communicates directly with a controller via  
B port. 

 
  There are two ways to monitor points. The first way is to display a point monitor 

dialog box that shows point value/state, engineering unit, and mode (automatic or 
manual). The second way is to select a switching table in the View Switching Logic 
function. Software automatically monitors all points in the switching table without 
displaying monitor dialog boxes. Both functions can be used at the same time. 
 

  This section describes point monitoring via point selection. Refer to the View 
Switching Logic section for a description of monitoring switching table points. 
 

 Assumption Application program is running in the controller. 
 
 Procedure 1. In any view (control strategy, switching logic, or user addresses), click the arrow 

head on the hardware points line to monitor the desired DIO hardware point. 
 

RESULT: The corresponding monitor dialog box displays showing the user 
address in the title line, the current value (for example, 302.0) and 
the engineering unit (for example, Deg or blank), or status (for 
example, ON or OFF, Normal or Alarm . If a selected point is in 
manual override, the hand symbol at the left side and the term 
“Remote” indicates this. 

 

 
 

 The LED symbol at the left corner indicates the current mode of the 
monitor dialog box: 

 
• Gray 

Indicates normal mode. 
• Green 
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 A point update has occurred.  
• Yellow 
 The point is in alarm. Note that the yellow LED shows only if 

you toggle in and out of the Monitor(s) dialog box. There is 
no automatic refresh. 

 
 The Monitor(s) dialog box displays if not already opened (see 

Monitor(s) Dialog Box section). 
 

IMPORTANT 
It is not possible to fix a hardware point which is in “manual override” mode. 

 
  2. To check point functions: 
   
 • Note value and state changes 
 • Use the Monitor(s) dialog box to stop monitoring, freeze values/statuses, 

refresh values/statuses, and restart monitoring as desired. See the 
Monitor(s) dialog box section for details 

    
 3. To stop monitoring when using a simulated controller, click Stop in the 

simulation software window at the bottom of the screen.  
   

RESULT: This stops the application program running in the controller. All 
monitor dialog boxes remain open on the screen. 

 
 4. To end monitoring one single point/, click the system menu in the individual 

point monitor dialog box and select Close. 
 
 5. To end monitoring, click Close in the Monitor(s) dialog box or select a different 

plant via Open dropdown item from the File menu. 
  

RESULT: This closes all monitor dialog boxes. The application program is still 
running in the (simulated) controller. Click STOP in the simulation 
software window if you want to stop the application program. 

 
 

Monitor Z-Registers 
 Purpose Display of a selected z-register value as it changes in the controller. The value is 

polled as long as the monitor dialog box is open (green LED symbol is flashing) and 
the Freeze or Refresh option in the Monitor(s) dialog box is not selected. Refer to 
the Modify Z-Registers section for modifying z-registers. 
 
NOTES: Z-registers access can be enabled/disabled in the CARE INI file (see SET 

CARE.INI FILE ENTRIES chapter). 
 
 Z-registers can be accessed in general, from special flag points, and from 

XFMs. With the procedure described in this section you can select and 
monitor any existing z-register. For this you must know the file and index 
number from the z-register you want to monitor.  

 
There are two ways to monitor z-registers. The first way is to display a z-register 
monitor dialog box that shows the current value. The second way is to select a 
switching table in the View Switching Logic function. Software automatically monitors 
all z-registers and points in the switching table without displaying monitor dialog 
boxes. Both functions can be used at the same time. 
 
Refer to the Monitor Flag Points section for directly monitoring z-registers of flag 
points and to the Monitor XFM Z-Registers section for directly monitoring z-registers 
of an XFM.  
 

 Assumption Application program is running in the (simulated) controller. 
 
 Procedure 1. In any view (control strategy, switching logic, or user addresses), choose Z-

Registers from the View menu. The Select Z-Register dialog box displays. 
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  2. Into the Z-Register File field enter the desired number. 
 
  3. Into the Z-Register Index field enter the desired number. 

 
NOTE: The fields for file and index do accept numbers (0 …9) only and up to 

3 characters. The z-register number is equal to the parameter file 
number of the submodule that contains the z-register. The parameter 
list printout shows which file number is assigned to which submodule. 

 
4. Click Display.  

 
RESULT: The corresponding monitor dialog box displays showing the current 

value of the z-register. The title line displays z-register identification 
in brackets (file number, index).  

 

 
 
 The LED symbol at the left corner indicates the current mode of the 

z-register monitor dialog box:  
 

• Gray 
Indicates normal mode. 

• Green 
 The z-register was polled. The z-register is polled as long as 

the monitor box is open and the Freeze or Refresh option in 
the Monitor(s) dialog box is not selected. 

 
  5. To check z-register functions: 
   
 • Note value changes 
 • Use the Monitor(s) dialog box to stop monitoring, freeze values, refresh 

values, and restart monitoring as desired. See the Monitor(s) dialog box 
section for details 

 • Use the Modify dropdown item from the system menu in individual z-
register monitor dialog boxes to change a z-register value as desired 
(see the Modify Z-Registers section for details). 

 
 6. To stop monitoring when using a simulated controller, click Stop in the 

simulation software window at the bottom of the screen. 
 
RESULT: This stops the application program running in the controller. All 

monitor dialog boxes remain open on the screen. 
 
  7. To end monitoring one single z-register, click the system menu in the individual 

z-register monitor dialog box and select Close. 
 
 8. To end all monitoring, click Close in the Monitor(s) dialog box or select a 

different plant via Open dropdown item from the File menu. 
  

RESULT: This closes all monitor dialog boxes. The application program is still 
running in the (simulated) controller. Click STOP in the simulation 
software window if you want to stop the application program. 

Monitor XFM Z-Registers 
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 Purpose Display of an XFM z-register value as it changes in the controller. The value is 
polled as long as the monitor dialog box is open (green LED symbol is flashing) and 
the Freeze or Refresh option in the Monitor(s) dialog box is not selected.  
 
Z-registers can be accessed in general, from flag points, and from XFMs. With the 
procedure described in this section you can select and monitor z-registers from any 
XFM control symbol. For modifying an XFM z-register refer to the Modify XFM Z-
Registers section.  
 
NOTE: The Z-Registers option in the Symbol Infomation dialog box is not visible,  

if  z-registers access is disabled in the CARE.INI file (see SET CARE.INI 
FILE ENTRIES chapter). 

 
 Assumption Application program is running in the (simulated) controller. 
 
 Procedure 1. Select Control Strategy from the View menu. 
 

RESULT: The View Control Strategy displays. 
 

 
 
 
 2. Select the desired control strategy and click OK. 

 
RESULT: The control strategy displays. 

 
  3. Click the symbol with the left mouse button.  
   

RESULT: The Symbol Information dialog box displays.  
 

 
 

   or 
 

   Click the symbol with the right mouse button to open the context menu. 
 

 
 
  4. In the Symbol Information dialog box select Z-Registers and confirm by clicking 

OK. In the context menu click Z-Register. 
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RESULT: The Select Z-Register dialog box displays. The dialog caption 
shows the XFM position in the control strategy in brackets (column, 
row). The z-register file number is already set to match the XFM. 

 

 
 

  5. Enter the z-register index into the Z-Register Index field. 
 
NOTE: The field do accept numbers (0 …9) only and up to 3 characters. The 

Z-Register File field is disabled.  
 

  6. Click Display 
 
RESULT: The corresponding monitor dialog box displays showing the current 

value of the z-register. The title line displays the XFM name, 
followed by the position in brackets (column, row), followed by the 
z-register identification in brackets (file number, index number).  

 

 
 

 The LED symbol at the left corner indicates the current mode of the 
monitor dialog box:  

 
• Gray 

Indicates normal mode. 
• Green 
 The z-register was polled. The z-register is polled as long as 

the monitor box is open and the Freeze or Refresh option in 
the Monitor(s) dialog box is not selected. 

 
 The Monitor(s) dialog box displays if not already opened (see 

Monitor(s) Dialog Box section). 
 
 7. To check z-register functions: 
 
 • Note value changes 
 • Use the Monitor(s) dialog box to stop monitoring, freeze values, refresh 

values, and restart monitoring as desired. See the Monitor(s) dialog box 
section for details 

 • Use the Modify dropdown item from the system menu in individual z-
register monitor dialog boxes to change a z-register value as desired 
(see the Modify Z-Registers section for details). 

 
 8. To stop monitoring when using a simulated controller, click Stop in the 

simulation software window at the bottom of the screen.  
   

RESULT: This stops the application program running in the simulated 
controller. All monitor dialog boxes remain open on the screen. 

 
 9. To end monitoring one single z-register, click the system menu in the individual 

z-register monitor dialog box and select Close. 
 
 10. To end all monitoring, click Close in the Monitor(s) dialog box or select a 

different plant via Open dropdown item from the File menu. 
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RESULT: This closes all monitor dialog boxes. The application program is still 
running in the (simulated) controller. Click STOP in the simulation 
software window if you want to stop the application program. 

 
 

Fix/Unfix Points 
 Purpose To fix a point means to change point mode from automatic to manual. To unfix a 

point means to change point mode from manual to automatic. Automatic (Auto) tells 
the system to update point value/status according to sensor or actuator readings. 
“Manual” allows you to assign a point value/status that the system cannot change. 

  For example, you can assign a low value to an outdoor air temperature point to see 
how the controller will react. 

  The following points can be fixed/unfixed: 
 
• Hardware points 
• Software points 
• Internal user addresses and mapped parameters of XFMs 
 
IMPORTANT 

Software maintains the manual value or status for the point and does not 
change it until you change point mode to Auto. 

 
 Procedures 1. Begin monitoring the point you want to fix (if it is not already being monitored).  
 
  The Monitoring section describes monitoring for hardware, software and XFM 

points. The View Switching Logic section describes monitoring for switching 
tables. 

 
 Fix a point 2. To fix a point that has a point dialog box (that is, non-switching table points), 

click the System menu in the monitor point dialog box and select Fix Point.  
 

RESULT: A check mark is added to the Fix Point dropdown item.  
 

 
 
NOTE: The monitor dialog box remains open as long as the Fix Point 

dropdown item is checked irrespective of whether the point is in 
manual (fixed) or automatic mode (unfixed). In order to fix or unfix a 
point the Fix Point dropdown item must be checked.  

 
  To fix a switching table point, click point value/state in the gray area in the 

switching table. 
 

RESULT: The point monitor dialog box displays with Manual/Auto options.  
 

 
 

 User address displays in the dialog box title line. Point value/status, 
engineering unit, and mode display in the dialog box. 

 
 3. To assign a value or status, click Manual. Then, for an analog point, type 

desired value in the field to the right of Manual. For a digital point, type desired 
status in the field to the right of Manual, or click down arrow to display possible 
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statuses and click one to select it. For a flex point, click selections relevant to 
the point.  

 
NOTE: You cannot change value or status unless you select Manual. 

 
 4. Click Command to save settings.  

 
RESULT: The point remains at that value/status until you unfix it. 

 
 Unfix a Point 1. Begin monitoring the point you want to unfix (if it is not already being 

monitored).  
 
 2. To unfix a point that has a point dialog box (that is, non-switching table points), 

click the System menu in the monitor point dialog box and click Fix Point if not 
already checked.  

 
  To unfix a switching table point, click point value/state in the gray area in the 

switching table. 
 
 3. Click Auto. 
 
 4. Click Command to save settings. 

 
RESULT: Software begins updating point value/status according to its 

sensor/actuator setting. 
 
 Error Messages If the controller returns an error message from an invalid command (for example, 

point command value out of range....), Live CARE displays the message with the 
appropriate data. 

 
 Points Remain in Manual Mode When you close a plant, software displays the following dialog box asking if you want 

to scan for points in Manual Mode. 
 

 
 
If you click No, any points set to Manual Mode remain in that mode. 

 
 Points Return to Auto Mode 1. Click Yes to return points in Manual Mode to Auto Mode. 
 

RESULT: The Scanning Points message box displays.  
 

 
 

 
 After all points in the project have been scanned for Manual Mode, 

the Change Points to Auto Mode dialog box displays. 
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 2. To change points back to Auto Mode, highlight the desired points with SHIFT 
and left mouse button and click OK. 

 

 
 

RESULT: The selected points are returned to Auto Mode and the dialog box 
closes. 

 
NOTE: The Change Points to Auto Mode function is not available when using 

the static simulator. 
 
 

Modify Flag Points 
 Purpose Change a z-register value from a flag point. Modifiying a z-register value is different 

from the “Fix” mechanism for points, because the value is only written to the 
controller once and is not maintained afterwards. After the next poll cycle the 
previous value is established.  
 
For modifiying z-registers in general refer to the Modify Z-Registers section. For 
modifying z-registers of XFMs refer to the Modify XFM Z-Registers section. 
 

 Assumption Application program is running in the (simulated) controller. 
 
 Procedure 1. In any view (control strategy, switching logic, or user addresses), click the 

desired flag point (abbreviations are: FA = analog flag point, FD=digital flag 
point) on the software points line.  

 
RESULT: The Analog Flag and Digital Flag dialog box respectively displays 

showing the current value of the corresponding z-register.  
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 2. Click the system menu (window symbol) at the upper left corner and select 
Modify. 

 

 
 

RESULT: The additional New value field and the Modify button appears. A 
check mark is added to the Modify dropdown item in the system 
menu. 

 
NOTE: The monitor dialog box remains open as long as the Modify dropdown 

item is checked. In order to modify a flag point the Modify dropdown 
item must be checked.  

 

 
 
  3. Enter the new value and click Modify. For digital flags it is only allowed to enter 

0 or 1. For analog flags it is only allowed to enter a positive or negative float 
number. 

 
RESULT: The new value is written to the z-register. 
 
NOTE: Modifiying a value is different from the "Fix" mechanism on points, 

because the value is only written to the controller once and is not 
maintained afterwards. While your application program is running it 
could seem as if the modified value is not accepted. That stems from 
the fact that the RACL application program has in the meantime 
already overwritten the value you entered, for example see the 
following monitor dialog box. 

 

 
 
 

Modify Z-Registers  
 Purpose Change a z-register value. With the procedure described in this section you can 

select and modify any existing z-register, that is, z-registers in general, from flag 
points and from XFMs. For this you must know the file and index number from the z-
register you want to monitor.  
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Modifiying a z-register value is different from the  "Fix" mechanism for points, 
because the value is only written to the controller once and is not maintained 
afterwards. After the next poll cycle the previous value is established.  
For modifiying z-registers of flag points or XFMs refer to the Modify Flag Points and 
Modify XFM Z-Registers sections respectively. 
 

 Assumption Application program is running in the (simulated) controller. 
 
 Procedure 1. In any view (control strategy, switching logic, or user addresses), choose Z-

Registers from the View menu. The Select Z-Register dialog box displays. 
  

 
 

  2. Into the Z-Register File field enter the desired number. 
 

  3. Into the Z-Register Index field enter the desired number. 
 
NOTE: The fields for file and index do accept numbers (0 …9) only and up to 

3 characters. 
 
4. Click Display.  

 
RESULT: The corresponding z-register monitor dialog box displays showing 

the current value of the z-register.  
 

 
 

  
 5. Click the system menu (window symbol) at the upper left corner and select 

Modify.  
 

RESULT: The additional New value field and the Modify button appears. A 
check mark is added to the Modify dropdown item in the system 
menu. 

 
NOTE: The monitor dialog box remains open as long as the Modify dropdown 

item is checked. In order to modify a z-register the Modify dropdown 
item must be checked.  

 

 
 
  6. Enter the new value and click Modify. For digital flags it is only allowed to enter 

0 or 1. For analog flags it is only allowed to enter a positive or negative float 
number. 

 
RESULT: The new value is written to the z-register. 
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NOTE: Modifiying a value is different from the "Fix" mechanism on points, 

because the value is only written to the controller once and is not 
maintained afterwards. While your application program is running it 
could seem as if the modified value is not accepted. That stems from 
the fact that the RACL application program has in the meantime 
already overwritten the value you entered, for example see the 
following monitor dialog box. 

 

 
 
 

View/Change Symbol Information 
 Purpose View/Change the following items from control strategy symbols:  

 
• Inputs 
• Internal parameters 
• Internal user addresses, mapped parameters, and  z-registers of XFMs 
 
NOTE: Not all items are necessarily available for each control strategy symbol. For 

example, only XFMs have internal user addresses and mapped 
parameters. The Z-Registers option is generally not available, if z-registers 
access is disabled in the CARE.INI file (see SET CARE.INI FILE ENTRIES 
chapter). 

 
 Procedure Symbol Information can be accessed in two ways: 

 
 1. First, if not already opened, open the control strategy by clicking View and then 

dropdown item Control strategy. 
 

 2. Click the symbol with left mouse button to open the Symbol Information dialog 
box. 

 

 
 

  or 
 
  Click the symbol with the right mouse button to display the following context 

menu. 
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Items which are not availbable for the selected symbol are disabled, that is, gray in 
the Symbol Information dialog box and totally missing in the context menu. 
 
For example, The Inputs option is inactive/missing, if there are no “entered-value” 
inputs for the symbol. For example, if all inputs to a PID are outputs from other 
symbols, physical points, or pseudopoints, the Inputs option is gray. Parameters is 
inactive/missing, if the symbol does not provide any parameters to assign. Internal 
User Addresses and Mapped Parameters as well as z-registers are inactive/missing 
unless the symbol selected is an XFM.  

 
 3. Select the desired item by clicking the radio button in the Symbol Information 

dialog box and by clicking the option in the context menu respectively. 
 
Refer to the following sections for viewing/changing the corresponding items (Inputs, 
Parameters etc.) of a control symbol. 
 
 

View/Change Symbol Inputs 
 Purpose View/Change input parameter values for a control symbol in the plant control 

strategy. 
  During control symbol assignment in Excel CARE, you assign inputs and outputs for 

control symbols. Live CARE allows you to change these input parameters and save 
them to the CARE database and controller. 

 
 Procedure 1. Open the Symbol Information dialog box by clicking the control symbol with the 

left mouse button or display the context menu by clicking the control symbol 
with the right mouse button.  

 
 2. In the Symbol Information dialog box, click Inputs and confirm by clicking OK. In 

the context menu, click Inputs. 
 

RESULT: The Input Parameters dialog box displays. For example, for a PID 
control symbol, the following dialog box can display: 

 

 
 

NOTE: The dialog box is the same as in Excel CARE except for the addition of 
the Update CARE database check box. If this box has a checkmark, 
Live CARE writes any changes you make to the CARE database when 
you click OK. If the box does not have a checkmark, changes you 
make are not saved in the database, when you leave Live CARE. 
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 3. In Input Parameters dialog boxes of I/Os, you can change any input that is a 

parameter only if the input box does not have an x. If there is a checkmark, you 
cannot change it. You also cannot change an input point into a parameter or 
vice versa. If you need to make those changes, use Excel CARE. There are 
also special conditions for the RAMP and SEQ control icons and for XFMs. See 
the RAMP and SEQ Operation note following this procedure. For changing 
Internal user addresses, mapped parameters , and z-registers of XFMs see the 
Change XFM Internal User Addresses and Mapped Parameters and Modify 
XFM Z-Registers sections respectively. 

 
 4. Click OK to save changes and update the controller file. If the Update CARE 

database check box has a checkmark, software also updates the CARE 
database. Otherwise, software only updates the controller. The check box 
defaults to checkmark (always update the CARE database). 
 
RESULT: The dialog box closes and the View Control Strategy window 

displays. 
 
 RAMP and SEQ Operation In CARE, you define minimum and maximum inputs and outputs as well as a ratio. 

The controller does not store these values. It stores minimum and maximum outputs 
and translated values that represent slope and y intercept. The following formulas 
represent the controller translation: 

 

SLOPE = 
MaxOutput  —  MinOutput

MaxInput  —  MinInput

Y INTERCEPT = 
MinOutput

Slope * MinInput   
 
 

View/Change Symbol Parameters  
 Purpose View/Change internal parameter values for a control symbol in the plant control 

strategy.  
 
  During control symbol assignment in Excel CARE you assign internal parameters for 

some symbols related to the symbol function, for example, proportional band and 
derivative time for the Proportional-Integral-Derivative (PID) symbol. Live CARE 
allows you to change these internal parameters and save them to the CARE 
database and controller. 

 
 Procedure 1. Open the Symbol Information dialog box by clicking the control symbol with the 

left mouse button or display the context menu by clicking the control symbol 
with the right mouse button.  

 
 2. In the Symbol Information dialog box, click Parameters and confirm by clicking 

OK. In the context menu, click Parameters. 
 

RESULT: The corresponding dialog box for internal parameters displays. The 
following figures show an example for a PID and an XFM control 
symbol. 
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 Note that the dialog boxes are the same as in Excel CARE except 
for the addition of the Update CARE database check box. If this box 
has a checkmark, Live CARE writes any changes you make to the 
CARE database when you click OK. If the box does not have a 
checkmark, changes you make are not saved in the database, 
when you leave Live CARE.  

 
 Also, parameters dialog boxes include an information line at the 

bottom of the dialog box that shows the valid value range for the 
currently selected item. 

 
 The parameter dialog box of an XFM shows the parameters with its 

index, value and unit. All parameters that are mapped to data points 
are marked as mapped by an asterics. The corresponding datapoint 
is displayed in the Mapped to: line when selecting the parameter in 
the list. 

 
 Control symbols other than XFMs 3. To change parameters for a symbol other than an XFM, enter the desired value 

into the field. You can change any of the parameters that are framed. Unframed 
Parameters are static text and cannot be changed.  

 
NOTE: Live CARE does not do any error checking for validity. 
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 4. Click OK to save changes and update the controller file. If the Update CARE 
database check box has a checkmark, software also updates the CARE 
database. Otherwise, software only updates the controller. The check box 
defaults to a checkmark (always update the CARE database). 
 
RESULT: The parameter dialog box closes and the View Control Strategy 

window displays. 
 

 XFM control symbols 3. To change a parameter of an XFM control symbol, click the parameter, enter 
the new value into the New Value field and click Modify. 

 
RESULT: Software starts limit checking. If the new value is within the range 

as shown in the information line at the bottom of the dialog box, it is 
accepted without a warning. If the value exceeds the high or low 
limit a warning dialog box appears asking if you reallly want to 
change the value.  

 

 
 

  4. Clicking Yes accepts the new value, clicking No discards the new value.  
 
NOTE:  The limits are float values stored in the *.csd file for each XFM. 

 
  5. Click OK to confirm the modified parameter. 

 
 6. Click OK in the parameter dialog box to save changes and update the controller 

file. If the Update CARE database check box has a checkmark, software also 
updates the CARE database. Otherwise, software only updates the controller. 
The check box defaults to a checkmark (always update the CARE database). 
 
RESULT: The parameter dialog box closes and the View Control Strategy 

window displays. 
 
 

Change XFM Internal User Addresses and Mapped Parameters 
 Purpose Change values/statuses of XFM datapoints which are internal user addresses or 

mapped to parameters. 
   
 Procedure 1. Open the Symbol Information dialog box by clicking the control symbol with the 

left mouse button or display the context menu by clicking the control symbol 
with the right mouse button.  

 
 2. In the Symbol Information dialog box, click Internal User Addresses and 

Mapped Parameters and confirm by clicking OK. In the context menu, click 
Datapoints. 
 
RESULT:  The Select User Adress dialog box displays showing all internal 

user addresses and mapped parameters of the selected XFM. 
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   The XFM is displayed prefixed by the position of the XFM in the control strategy 

(column, row). If there are no internal data points and/or mapped parameters 
available for the desired XFM the Internal Data Points and/or Mapped 
Parameters structure is not expanded. 

 
  3. Click the internal datapoint or the mapped parameter and dick Display. 

 
RESULT: The corresponding monitor dialog box is displayed.  

 

 
 

 Fix Point 4. For changing value/status of the internal datapoint or the mapped parameter 
click the System menu in the monitor point dialog box and select Fix Point.  

 
RESULT: A check mark is added to the Fix Point dropdown item. The point 

monitor dialog box displays with Manual/Auto options.  
 

 
 

 5. To assign a value or status, click Manual. Then, for an analog point, type 
desired value in the field to the right of Manual. For a digital point, type desired 
status in the field to the right of Manual, or click down arrow to display possible 
statuses and click one to select it. For a flex point, click selections relevant to 
the point.  

 
NOTE: You cannot change value or status unless you select Manual. 

 
 6. Click Command to save settings.  

 
RESULT: The point remains at that value/status until you unfix it. 

 
 Unfix Point 1. To unfix a internal user address or a mapped parameter, click the System menu 

in the monitor point dialog box and click Fix Point if not already checked. 
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 2. Click Auto. 
 
 3. Click Command to save settings. 

 
RESULT: Software begins updating point value/status according to its 

sensor/actuator setting. 
 
 

Modify XFM Z-Registers 
 Purpose View/Change z-register values of an XFM symbol in the plant control strategy. 
 
 Procedure 1. Open the Symbol Information dialog box by clicking the XFM symbol with the 

left mouse button or display the context menu by clicking the XFM symbol with 
the right mouse button.  

 
 2. In the Symbol Information dialog box, click Z-Registers and confirm by clicking 

OK. In the context menu, click Z-Registers. 
 

RESULT: The Select Z-Register dialog box displays. 
 

 
 

  3. Enter the z-register index into the Z-Register Index field. 
 
NOTE: The field do accept numbers (0 …9) only and up to 3 characters. The 

Z-Register File field is disabled and cannot be changed.  
 

  4. Click Display. 
 
RESULT: The corresponding monitor dialog box displays showing the current 

value of the z-register. The title line displays the symbol name, Z 
and the file and index number from the z-register.  

 

 
 

 5. Click the system menu (window symbol) at the upper left corner and select 
Modify.  

 
RESULT: The additional New value field and the Modify button appears. A 

check mark is added to the Modify dropdown item in the system 
menu. 

 
NOTE: The monitor dialog box remains open as long as the Modify dropdown 

item is checked. In order to modify a z-register the Modify dropdown 
item must be checked.  

 
 6. Enter the new value and click Modify. For digital flags it is only allowed to enter 

0 or 1. For analog flags it is only allowed to enter a positive or negative float 
number. 
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RESULT: The new value is written to the z-register. 
 

 
 
NOTE: Modifiying a value is different from the "Fix" mechanism on points, 

because the value is only written to the controller once and is not 
maintained afterwards. While your application program is running it 
could seem as if the modified value is not accepted. That stems from 
the fact that the RACL application program has in the meantime 
already overwritten the value you entered, for example see the 
following monitor dialog box. 
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SET CARE.INI FILE ENTRIES 
Besides others the following entries concerning z-registers are relevant for Live 
CARE and can be changed: 
 

 Z-Register Access Z-registers access can be set in the [User Privileges] section as follows: 
 
Example: 
 
[User Privileges] 
CanAccessZRegs=1 
 

  The “CanAccessZRegs” entry must be set to 1 to enable z-register access. No, off 
or 0 disables z-register access. If access is disabled the Z-Registers dropdown item 
from the View menu and the Z-Registers option in the Symbol Information dialog box 
is not visible. In addition, disabled z-register access effects flag points, that they also 
can not be accessed.  
 

 Z-Register Poll Cycle The minimum time between 2 z-register poll actions can be set in the [LiveCARE] 
section as follows: 
 
Example: 
 
[LiveCARE] 
MinZRegisterPollCycle=5 ; time value in seconds 
 
The value is read as integer number and values less than 1 will be treated as 1. 
Default value is 5 seconds. 
 
 

 Password The password can be set in the [LCDisp Goodies] section: 
 
[LCDisp Goodies] 
XL500DefaultPassword=3333 
 
The pasword can be set to a 4 digit numeric value. Default value is 3333. 
 

 Port, Interface The default selection for the Port and Interface options in the Communications 
dialog box can be set in the [LCDisp Goodies] section as follows: 

 
[LCDisp Goodies] 
XL500SetPortDefault=1 
XL500SetSimulatorDefault=1 
 
The PortDefault can be set to 1 through 4. 1 sets COM1, 2 sets COM2 to default 
port, etc.  
The SimulatorDefault can be set to 0 or 1. 1 sets the Simulator to the default 
Interface, 0 sets the B-Port to the default interface.  
 
 

 Procedure 1. Double-click the CARE.INI file in the WINDOWS folder (by default) to open 
the file via Notepad Editor. 

  
 2. Edit the desired entries and select Save from the File menu. 
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ERROR MESSAGES 
This chapter lists error messages that may display during Live CARE operation 
and describes possible causes. In addition, a second error message table lists 
error messages that may occur while you are running a simulation in Live CARE. 

 

General Error Messages 

Error Message Possible Causes 
Out of local memory Windows cannot allocate any local memory. Exit Windows and re-start your 

computer. 
Out of global memory Windows cannot allocate any global memory. Exit the application and close 

other applications to free more memory. 
Cannot connect to network, no devices on 
network 

Exit the Commissioning Tool and add devices to the network using CARE. 

  
  
  
  
Controller Name mismatch The Controller and CARE database have different names. You are probably 

attached to the wrong controller. 
Cannot determine controller type Controller files not found. Retranslate controller. 
No valid comm ports in system Your computer’s communication port(s) are already in use or improperly 

configured. 
Invalid LDVSLTA.SYS driver in config.sys The SLTA Driver is corrupted. Reboot the PC. If that does not work, reinstall 

Live CARE. 
Too many switching logic monitors Switching Logic Monitors are monitors just like the Point Monitors. The 

controller in use may have a point display limitation. 
Data Server has disconnected The Data Server has disconnected prematurely. Exit Live CARE and restart. 
Unable to Connect to Data Server The Data Server will not start. Exit Live CARE. If the LCSRVR icon is still 

active, close it. 
Unable to get the data from the controller The Communications Manager for the controller type is failing the Advise 

Request for point updates. The controller in use may have a point display 
limitation. 

Error assigning address to the controller The Communications Manager is failing the address assignment. The 
controller may not be responding. 

Unable to enter service pin mode Exit and restart Live CARE. 
Controller already in use Another tool is logged into the device that you are trying to access. Wait until 

the other tool has logged out of the device and try again. If no other tool is 
logged in, wait for device to time out on login (usually 1 minute) and try again. 

Comm Manager not logged into controller Connection with device has failed. Check power to device, wiring, SLTA or B-
Port connection, and power. 

No SLTA Network Management Nodes 
available 

Exceeded limit of SLTA devices on network. Remove one or more SLTAs from 
network and try again. 

Error on i/f port Cannot communicate to SLTA or B-Port. Check power to interface device and 
wiring connection. 

No message within timeout period Device is not responding to message. Check connection between interface 
device and network. Check network connection to device. Verify device is 
powered. You may need to cycle power on device. 

 
Specified key already exists 

Detected duplicate ID for device. Use different physical device or remove other 
device from network using Network Configuration in CARE. 

Error occurred accessing network Cannot communicate to SLTA or B-Port. Check power to interface device and 
wiring connection. You may need to cycle power on SLTA. 

Could not verify delivery of message to dest Device is not responding to message. Check connection between interface 
device and network. Check network connection to device. Verify device is 
powered. You may need to cycle power on device. 

Message not received within specified 
timeout period 

Device is not responding to message. Check connection between interface 
device and network. Check network connection to device. Verify device is 
powered. You may need to cycle power on device. 

Cannot determine controller type Controller files not found. Retranslate controller. 
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Simulation Error Messages 

The following errors can display in unusual circumstances.  
  
Your first step in most cases is to verify that the CARE data file for the selected 
controller was translated after the last changes were made so that all data file 
parameters are correct and up-to-date. If the same error displays after a new 
translation, contact the Honeywell Technical Assistance Center. 
 

Error Message Possible Cause 
" Bad ""defined"" constant Parameter" Design error. Report to Honeywell Technical Assistance Center. 
(characters) String passed in was too long Design error. Report to Honeywell Technical Assistance Center. 
(file name) File existence error The named controller file is missing from the CARE directory. Retranslate the 

controller. If error persists, contact the Honeywell Technical Assistance 
Center. 

(file name) File I/O Error Hardware error. 
(file name) File size is larger than maximum The named file is not an application file or is corrupted. Retranslate the 

controller. If error persists, contact the Honeywell Technical Assistance 
Center. 

(file name) has a bad checksum The file is not an application file or is corrupted. Retranslate the controller. If 
error persists, contact the Honeywell Technical Assistance Center. 

(file name) has a short file header The file is not an application file or is corrupted. Retranslate the controller. If 
error persists, contact the Honeywell Technical Assistance Center. 

(file name) is too long to load The file is not an application file or is corrupted. Retranslate the controller. If 
error persists, contact the Honeywell Technical Assistance Center. 

(file name) is truncated The file is not an application file or is corrupted. Retranslate the controller. If 
error persists, contact the Honeywell Technical Assistance Center. 

(file name) Memory error Design error. Report to Honeywell Technical Assistance Center. 
(file name) was not found The file does not exist. Retranslate the controller. If error persists, contact the 

Honeywell Technical Assistance Center. 
(name) Controller File is not open The file is not an application file or is corrupted. Retranslate the controller. If 

error persists, contact the Honeywell Technical Assistance Center. 
(name) Header Version incorrect The file is not an application file or is corrupted. Retranslate the controller. If 

error persists, contact the Honeywell Technical Assistance Center. 
(name) Illegal application ID The file is not an application file or is corrupted. Retranslate the controller. If 

error persists, contact the Honeywell Technical Assistance Center. 
(name) Padding state is wrong The file is not an application file or is corrupted. Retranslate the controller. If 

error persists, contact the Honeywell Technical Assistance Center. 
(name) Section open status error The file is not an application file or is corrupted. Retranslate the controller. If 

error persists, contact the Honeywell Technical Assistance Center. 
(name) The handle could not be locked Design error. Report to Honeywell Technical Assistance Center. 
(name) Unknown section ID referenced The file is not an application file or is corrupted. Retranslate the controller. If 

error persists, contact the Honeywell Technical Assistance Center. 
(name) Write protection status wrong The file is not an application file or is corrupted. Retranslate the controller. If 

error persists, contact the Honeywell Technical Assistance Center. 
A controller is already connected to Live 
CARE! 
Disconnect the controller or change the 
simulator service name (Port). 

Error message associated with the Simulator master mode. Test mode error 
only. 

Cannot determine controller type Controller files not found. Retranslate controller. 
Current version is: Simulator %1 Excel 
Controller %2 

Attempt to load an obsolete saved simulation session. 

DDE Server Error 
Unknown Topic. 

Another application made an unrecognized DDE request. Report to Honeywell 
Technical Assistance Center. 

DDE Server Error 
Unknown System conversation OnRequest 
item. 

Another application made an unrecognized DDE request. Report to Honeywell 
Technical Assistance Center. 

DDE Server Error 
Unknown Live Care conversation 
OnRequest item. 

Another application made an unrecognized DDE request. Report to Honeywell 
Technical Assistance Center. 

DDE Server Error 
Digital point state text length invalid. 

The controller application files are corrupted. Retranslate the controller. 
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DDE Server Error 
Digital point state text copy failed. 

The controller application files are corrupted. Retranslate the controller. 

DDE Server Error 
Flex point copy failed. 

The controller application files are corrupted. Retranslate the controller. 

DDE Server Error 
Point request search failed. 

A request was made for a non-existent user address. Retranslate the 
controller. 

DDE Server Error 
Point request encountered an unknown type 
of point. 

A request was made for an unknown point type. Retranslate the controller. 

DDE Server Error 
Zregister search failed. 

A request was made for a non-existent z-register. Retranslate the controller. 

DDE Server Error 
Parameter search failed. 

The parameter does not exist. Retranslate the controller. 

DDE Server Error 
Advise start point base search failed. 

A point referenced in an advise start transaction does not exist. Retranslate 
the controller. If error persists, contact the Honeywell Technical Assistance 
Center. 

DDE Server Error 
Advise start invalid parameter file number. 

A racl parameter referenced in an advise start transaction does not exist. 
Retranslate the controller. If error persists, contact the Honeywell Technical 
Assistance Center. 

DDE Server Error 
Advise start invalid parameter file index. 

A racl parameter referenced in an advise start transaction does not exist. 
Retranslate the controller. If error persists, contact the Honeywell Technical 
Assistance Center. 

DDE Server Error 
Advise start invalid item type. 

An advise start transaction was received that was not recognized. Retranslate 
the controller. If error persists, contact the Honeywell Technical Assistance 
Center. 

DDE Server Error 
Poke unknown item. 

The item does not exist. Retranslate the controller. If error persists, contact the 
Honeywell Technical Assistance Center. 

DDE Server Error 
Write point search failed. 

The point does not exist. Retranslate the controller. If error persists, contact 
the Honeywell Technical Assistance Center. 

DDE Server Error 
Poke point failed. 

The point does not exist. Retranslate the controller. If error persists, contact 
the Honeywell Technical Assistance Center. 

DDE Server Error 
Poke parameter failed. 

The parameter does not exist. Retranslate the controller. If error persists, 
contact the Honeywell Technical Assistance Center. 

DDE Server Error 
Poke ZRegister failed. 

The Z register does not exist. Retranslate the controller. If error persists, 
contact the Honeywell Technical Assistance Center. 

DDE Server Error 
Advise start invalid ZRegister. 

The Z register does not exist. Retranslate the controller. If error persists, 
contact the Honeywell Technical Assistance Center. 

DDE Server Error 
ZRegister search failed. 

The Z register does not exist. Retranslate the controller. If error persists, 
contact the Honeywell Technical Assistance Center. 

Error Reading Point Auto Value. The point does not exist. Retranslate the controller. If error persists, contact 
the Honeywell Technical Assistance Center. 

Error reading flex point class. The point does not exist. Retranslate the controller. If error persists, contact 
the Honeywell Technical Assistance Center. 

Error reading point engineering units. The point does not exist. Retranslate the controller. If error persists, contact 
the Honeywell Technical Assistance Center. 

Error reading point Hand Value. The point does not exist. Retranslate the controller. If error persists, contact 
the Honeywell Technical Assistance Center. 

File Error. The file could be missing, or in use by another application, or there could be a 
hardware problem. 

File is optional and will be ignored. The following controller file is missing from the CARE directory. This file is not 
required to operate the Simulator. 

Time Schedules file *.ZPG 



LIVE CARE ERROR MESSAGES 

  74-3556-9 (US) 
  EN2B-0183 GE51 R0404 (Europe) 

57

File is required for correct simulator 
operation. Continue Loading? 

One of the following controller files is missing from the CARE directory. This 
file is required to operate the Simulator. 

RACL program file *.RAL 
RACL parameter file *.RAP 
RACL intermediate register file *.RAZ 
RACL timer register file *.RAT 
ASPECD program file *.ADL 
Time Schedules file *.ZPG 
Data Point Description file *.IPL 
Point Descriptors file *.KLX 
Alarm text file  *.ALX  
State text file *.ZSX 
Engineering unit text file *.PHX  
Characteristics data file *.KDX 
Configuration data file *.KFX 

Edit the controller in CARE to create the necessary file. Retranslate. 
Global Memory Allocation Failed! Design error. Report to Honeywell Technical Assistance Center. 
Incompatible Simulation Save File! 
Save file version: Simulator %1 Excel 
Controller  %2 

Attempt to load an obsolete saved simulation session. 

Live CARE Simulation requires a system 
icon size of 32x32 pixels - please use a 
different video driver. 

Attempt to run the simulator with EGA or other rare display adapters that use 
other icon sizes. 

Live CARE still connected! 
Please disconnect before exiting simulator. 

Error message associated with the Simulator master mode. Test mode error 
only. 

Local Language Resource File not found - 
Terminating Simulator 

The LCUSA.DLL file that comes with Live CARE software is missing.  

Memory Free Failed Windows internal malfunction. 
Minimum compatible version: Simulator %1 
Excel Controller %2 

Attempt to load an obsolete saved simulation session. 

"No CARE path found - defaulting to 
""C:\\CARE""." 

Check Live CARE .INI file to correct CARE path. 

No Program Loaded An attempt was made to start the simulator before loading a controller 
application. Test mode error only.  

No timer available Other applications are using all the Windows timers. 
Not Implemented Yet User has accessed a future function not implemented in the current release of 

the Simulator. 
 NULL Parameter passed in Design error. Report to Honeywell Technical Assistance Center. 
RACL Application Not Running. Corruption of the racl program, illegal operations, etc., as detected by the 

XL500 racl interpreter. Retranslate the controller. If error persists, contact the 
Honeywell Technical Assistance Center. 

RACL Time Overflow Divide by zero overflow. Design error. Report to Honeywell Technical 
Assistance Center. 

Severe Internal Error %d in Module %d. 
Application will terminate now. 

Design error. Report to Honeywell Technical Assistance Center. 

Severe Internal Error!  Unused Function %s 
called. Application will terminate now. 

Design error. Report to Honeywell Technical Assistance Center. 

The selected file is neither a controller file 
nor a simulation save file 

Error message associated with the Simulator master mode. Test mode error 
only. 

"Unknown code tag %1 found by code 
coverage tracer,  Disable tracing?" 

Error message associated with the Simulator master mode. Test mode error 
only. 

Unknown flex point class The point class does not exist. Retranslate the controller. If error persists, 
contact the Honeywell Technical Assistance Center. 
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